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Conventions Used in this Guide

Please take a moment to review how instructions and other useful information are presented in
this documentation.

l Procedures are presented as numbered lists. A single bullet indicates that the procedure
has only one step.

l Bold type is used for the following:
o Keyboard entries that should be typed in their entirety exactly as shown. For
example, “copy file1” means you must type the word copy, then type a space, and
then type file1.

o On-screen prompts and messages, names of options and text boxes, and menu
commands. Menu commands are often separated by greater than signs (>). For
example, “click HFSS > Excitations > Assign >Wave Port.”

o Labeled keys on the computer keyboard. For example, “Press Enter” means to
press the key labeled Enter.

l Italic type is used for the following:
o Emphasis.
o The titles of publications.
o Keyboard entries when a name or a variable must be typed in place of the words in
italics. For example, “copy filename” means you must type the word copy, then
type a space, and then type the name of the file.

l The plus sign (+) is used between keyboard keys to indicate that you should press the
keys at the same time. For example, “Press Shift+F1” means to press the Shift key and,
while holding it down, press the F1 key also. You should always depress the modifier key
or keys first (for example, Shift, Ctrl, Alt, or Ctrl+Shift), continue to hold it/them down, and
then press the last key in the instruction.

Accessing Commands: Ribbons, menu bars, and shortcut menus are three methods that can
be used to see what commands are available in the application.

l The Ribbon occupies the rectangular area at the top of the application window and con-
tains multiple tabs. Each tab has relevant commands that are organized, grouped, and
labeled. An example of a typical user interaction is as follows:

"Click Schematic > Line"
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This instruction means that you should click the Line command on the Schematic ribbon
tab. An image of the command icon, or a partial view of the ribbon, is often included with
the instruction.

l Themenu bar (located above the ribbon) is a group of the main commands of an applic-
ation arranged by category such File, Edit, View, Project, etc. An example of a typical user
interaction is as follows:

"On the Filemenu, click theOpen Examples command" means you can click the File
menu and then clickOpen Examples to launch the dialog box.

l Another alternative is to use the shortcut menu that appears when you click the right-
mouse button. An example of a typical user interaction is as follows:

“Right-click and select Assign Excitation> Wave Port” means when you click the right-
mouse button with an object face selected, you can execute the excitation commands
from the shortcut menu (and the corresponding sub-menus).

Getting Help: Ansys Technical Support

For information about Ansys Technical Support, go to the Ansys corporate Support website,
http://www.ansys.com/Support. You can also contact your Ansys account manager in order to
obtain this information.

All Ansys software files are ASCII text and can be sent conveniently by e-mail. When reporting
difficulties, it is extremely helpful to include very specific information about what steps were
taken or what stages the simulation reached, including software files as applicable. This allows
more rapid and effective debugging.

Help Menu

To access help from the Help menu, click Help and select from the menu:

l [product name] Help - opens the contents of the help. This help includes the help for the
product and itsGetting Started Guides.

l [product name] Scripting Help - opens the contents of the Scripting Guide.
l [product name] Getting Started Guides - opens a topic that contains links to Getting
Started Guides in the help system.

Context-Sensitive Help

To access help from the user interface, press F1. The help specific to the active product (design
type) opens.

You can press F1 while the cursor is pointing at a menu command or while a particular dialog
box or dialog box tab is open. In this case, the help page associated with the command or open
dialog box is displayed automatically.
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1 - Introduction
The focus of this tutorial is to introduce the user to transmitter (Tx), receiver (Rx) and transceiver
(RT) models in EMIT by building a simple 1-Tx/1-Rx scenario. The simulation will be run using a
fixed value for the antenna-to-antenna coupling and the resulting EMI margin examined. An inter-
ference will be identified and mitigated via the addition of a filter.

Key Concepts
l Add Radios to an EMIT design

l Define Tx and Rx Bands

l Run a 1-on-1 simulation

l Interpretation of results

l Mitigation using a filter

Project Configuration
A pictorial representation of the scenario we will analyze is shown below. A single Tx and Rx
operating at different frequencies are evaluated for interference. The antenna-to-antenna coup-
ling in this tutorial will be modeled using a fixed, frequency-independent value. The Tx is oper-
ating at a frequency of 50 MHz and a peak power level of 40 dBm. The Rx is tuned to 500 MHz
and the in-channel susceptibility is -100 dBm.

Introduction 1-1

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Getting Started with EMIT - Tutorial 1

2 - Add Radios to an EMIT Design
Before starting the tutorial, we will change the units used in EMIT to MHz, to better suit the fre-
quency range that we will be using in the tutorial. To do so, selectGeneral Options from the
right side of the ribbon area under the Desktop tab, shown below.

In theOptions window, select EMIT from the list of categories, and then under Frequency select
MHz from the drop-down options. ClickOK to save the change.

Add Radios to an EMIT Design 2-1
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If you do not already have a new project open, create a new project by clicking New in the ribbon
area under the Desktop tab.

To add an EMIT Design to the new project, select EMIT from the ribbon area under the Desktop
tab. This can also be done by right-clicking the project in the Project Manager window and select-
ing Insert > Insert EMIT Design.

Save the project as "Tutorial 1" by clicking the Save icon in the ribbon area, shown below. Save
this to a folder somewhere in your user directory (as opposed to the EMIT installation directory,
which is read-only).

This tutorial uses two radios: a transmitter (Tx) and a receiver (Rx). To add radios to the design,
build them from the components found in the Schematic tab of the ribbon area, shown below.

To add a new radio, click on the Radio icon ( ) in the ribbon area and select New Radio.
Double-click on the new radio component created in the schematic, or right-click and select Con-
figure, to open its Radio Configuration window. In the top left of this window, you can find the
node tree for the new radio. Right-click on the node titled New Radio and select Rename. Name

Add Radios to an EMIT Design 2-2
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this radio Transmitter. The resulting Radio Configuration window is shown below. ClickOK to
close the window, which also automatically saves the changes to the design.

On the schematic, select the radio component by clicking on it, and then click again on the text
below the component to edit it. Rename the component to Transmitter. Repeat the steps above
to create a second radio component and rename it Receiver. . After creating and renaming the
two radios, click in any empty space on the schematic to deselect any selected components.
Click on the Antenna icon ( ) to add an antenna component to the schematic and automatically
connect it to a radio. Do this again to create a second antenna for the second radio. The res-
ulting schematic is shown below.

Add Radios to an EMIT Design 2-3
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EMIT designs maintain a history of actions performed and you can undo and/or redo actions in

the order that they were performed using the Undo and Redo buttons on the main
Desktop toolbar.

Add Radios to an EMIT Design 2-4
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3 - Define Radio Bands and Samplings
In EMIT, a radio's (Tx and Rx) capabilities are defined in the corresponding Configuration win-
dow, under the Radio node by specifying one or more Bands. Each Band has different operating
characteristics defined by that Band node and its child nodes. Once a Radio’s Bands have been
defined, the actual operating conditions desired for the scenario are defined by the radio's Samp-
ling. The Sampling node contains information related to the specific channels for which the radio
will operate in the current scenario. The sampling parameters defined for a radio can also be
used to simply reduce the number of channel combinations that EMIT needs to analyze as adja-
cent channels will often have similar cosite performance. The frequencies defined in a Sampling
must be a subset of the Bands; i.e., the radio must be programmed only within its operational
capabilities.

Band Definition
When radios are added to a project, a transmit/receive Band is automatically added to the radio.
For this tutorial though, we want to make the bands transmit only and receive only for the Tx and
Rx respectively. Double click the Transmitter radio to open the Transmitter Configuration win-
dow. To create a transmit only band, simply disable the Rx Spectral Profile node under the Band
node. The Band icon should update to reflect that it is a transmit only band.

Next, we will configure the Tx's modulation and operating channels. Select the Band node to dis-
play its property panel and enter the values as shown below.

Define Radio Bands and Samplings 3-1
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The Band node contains general properties that are required to define both transmit and receive
parameters. To define the transmit specific parameters for this Tx band, select the Tx Spectral
Profile node and enter the values as shown below. Detailed explanations for each parameter
can be found in the appropriate sections of the EMIT help. Note that you can access the EMIT
help by clicking the Help icon ( ) to take you to the documentation for that specific node.

Define Radio Bands and Samplings 3-2
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In a similar fashion create a receive only band for the Rx, by opening the Receiver Configuration
window, disabling the Tx Spectral Profile node, and then entering the parameters for the Rx
Band and Rx Spectral Profile, respectively, as below.

Define Radio Bands and Samplings 3-3
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In this instance we also know the IF that the receiver uses to downconvert the desired signals as
well as the specifications for the IF filters. Thus, we want to include this information in our cosite
analysis to increase the fidelity of the simulations. To do so add Mixer Product and Selectivity
Profile nodes to our Rx Spectral Profile. Right-click on the Rx Spectral Profile and select Add
Mixer Products and then repeat to Add Rx Selectivity. Edit the parameters of each of these, as
shown below.

The selectivity profile defines the shape of the Rx's response at the tuned channel which is
determined by its IF filters.

Define Radio Bands and Samplings 3-4
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Take some time to further explore the help sections for the Band settings, and the Tx and Rx
spectral profiles. The parameters specified in these nodes define the broadband characteristics
of the transmitter and receiver, respectively. For transceivers that use the same modulation for
transmitting and receiving as well as identical channels (or a fixed offset) a single Band can be
defined with the spectral profiles defining the Tx and Rx specific parameters.

Sampling Definition
The Bands define the complete operational capabilities of a radio. Typically though, in a given
scenario, a radio will only operate over a subset of its abilities. In EMIT, a radio is programmed
for a scenario using the radio's Sampling node to specify the channels that the radio will actually
operate on within the scenario. For example, a radio may be capable of operating on 100 chan-
nels (which is defined by the radio's Band), but for the scenario of interest, operation is restricted
to just 5 of these channels.

By default, a Sampling is added to the radio when it is created. After opening the Transmitter
Configuration window, select the Sampling node for the transmitter and enter the properties as
shown below. Note that we are only defining a single 50 MHz channel that the Tx will operate on
for this scenario. It is worth noting that the Total Tx Channels field shows the number of channels
that the Sampling has in common with all of the Bands defined for that Radio.

In a similar fashion, select the Sampling for the Receiver and enter the parameters as below.

Define Radio Bands and Samplings 3-6
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4 - Modify Radio Channels
Before proceeding with an exploration of ways radio channels can be modified, rename both
radios. This will facilitate adding more radios to this project in a later tutorial. Click on the Trans-
mitter radio to select it, then click the text below to edit its name and type in Tx-1 (Lo-VHF).
Change the name of the Receiver radio to Rx-0 (UHF). The schematic should now appear as
below.

Now we will explore the additional features that can be added to the already defined Tx and Rx
channels in EMIT. These features include adding Tx and Rx spurious responses (spurs), chan-
ging the transmitter harmonic levels, and changing the Rx mixer product levels.

Modify Radio Channels 4-1
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First, plot the Tx emissions spectral profile by double-clicking the Tx-1 (Lo-VHF) radio and select-
ing the Tx Spectral Profile node. A plot of the wideband Tx emissions will appear in the display
area on the right side of the window. The first channel of the Band, 30 MHz in this case, is dis-
played by default, but the plot can be changed to show any channel in the Band. By clicking
Band 30 MHz (Tx) Trace in the legend of the plot, the trace’s properties will be displayed. Set the
Channel Frequency to 50 MHz, which is the operating channel we will use for this simulation. By
clicking the Plot Properties icon ( ) above the plot, the plot properties will be displayed. Verify
that the X-axis Max value is set to 600 MHz. The resulting plot is shown below.

The Tx Spectral Profile has two components:

Modify Radio Channels 4-2
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l The narrowband component is in units of power. For our Tx, this component consists of
the Tx fundamental at the channel frequency of 50 MHz and a number of harmonics (the
number of harmonics included are specified in the Tx Spectral Profile definition). The amp-
litude of the harmonics in this case are set to the MIL-STD-461 limits.

l The broadband, or noise, spectral component is in units of power density (power/unit
bandwidth). We are currently using the default value of the unit bandwidth (1.0 Hz). There-
fore, our broadband noise units are dBm/Hz. For our Tx the noise floor has been specified
as being -174 dBm/Hz and we have enabled the option to compute the phase noise about
the channel frequency.

Clicking on a trace within the legend in the plot highlights that trace on the plot by increasing the
width of the trace. Plots have quite a bit of functionality built in for customizing the display. Refer
to the EMIT help for a detailed explanation of plot functionality by clicking on the Help icon ( ).

Based on the parameters specified in the Tx Band and Spectral Profile definitions, this is the
best model for the Tx emissions using the spec-sheet type data provided. However, EMIT allows
this spectral profile to be modified and refined as more data on the Tx performance becomes
available beyond the simple spec-sheet type information. For example, harmonic levels can be
adjusted to represent the actual levels and non-harmonic spurious emissions can also be
added. If Tx emissions data is available from another source (for example, measurements, RF
circuit simulations, and so on) this can be used in EMIT as well by importing the data into the
appropriate node.

To adjust the level of a specific harmonic, right-click on the Tx Spectral Profile node and choose
Add Custom Tx Harmonics. A Harmonics node will appear under the Tx Spectral Profile node.
In the Harmonics property panel, add a row to the table to adjust the amplitude of the desired har-
monic(s) (note that the fundamental is harmonic number 1, the first harmonic is harmonic num-
ber 2, etc.). For this tutorial, we'd like to set the amplitude of the 2nd harmonic to -75 dBm as
shown below. Note that the plot of the harmonics will automatically update after making the
changes. Any number of harmonics can be modified using this table and external CSV files con-

taining the harmonic numbers and their amplitudes can also be imported via the import icon (
).

Modify Radio Channels 4-3
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To add a non-harmonic spur, right-click on the Tx Spectral Profile node and select Add Spurious
Emissions. A Spurious Emissions node will appear under the Tx Spectral Profile. Spurs can be
defined as either fixed or relative. Fixed spurs remain at the specified frequency regardless of
the channel frequency, while relative spurs appear at a specified offset from the channel fre-
quency for each channel defined in the Band. In the Spur property panel, add a row to the table
and enter "RF+10" in the Frequency column. The RF variable specifies that it is a relative spur,
and that the frequency of the spur will be set to 10 MHz above the tuned channel. Define the
spur's bandwidth and amplitude as shown below. As before, the plot will automatically update
after the changes are made. Any number of spurs can be added via this table and external CSV
files containing the spurs' frequency, bandwidth and amplitude can also be imported via the

import icon ( ).

Modify Radio Channels 4-4
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Similarly, we can modify the Rx Spectral Profile by editing mixer product responses and adding
non-mixer product spurious responses. Plot the Rx Spectral Profile by selecting the Rx Spectral
Profile node in the Rx-0 (UHF) Configuration window. A plot of the wideband Rx susceptibility
will appear in the display area. In the Trace node's property panel, which is accessed by select-
ing Band 100 MHz (Rx) in the legend of the plot, set the Channel Frequency to 500 MHz to dis-
play the corresponding channel for the Rx band.

Modify Radio Channels 4-5
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The wideband Rx susceptibility for this 500 MHz channel shows an in-channel susceptibility of -
100 dBm, a saturation level of +20 dBm and multiple mixer products as previously specified in
the Rx Band's Mixer Product node. Recall that the mixer product levels in this case are defined
by the statistical Duff Model.

Use the left mouse button in the Rx plot window to "rubber-band" zoom in to view the sus-
ceptibility response around 500 MHz. The shape of the susceptibility curve in this region is
defined according to the Selectivity Profile child node of the Rx Spectral Profile. You can also
control the exact axis extents from the plot property panel, opened by clicking the Plot Properties
icon ( ).

Modify Radio Channels 4-6
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Double-click in the Rx plot area to reset the zoom for the Rx susceptibility plot. The susceptibility
spectral profile can also be modified as higher fidelity data becomes available as was done for
the Tx emissions spectral profile above. For the Rx, we can adjust mixer product levels and add
other spurious responses.

Select theMixer Products node which was previously added for the Rx. In the Mixer Products
property panel, add a row to the table and set the parameters as shown below. Observe the
change in the susceptibility plot.

Modify Radio Channels 4-7
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Next, we want to add a spurious response to our Rx Spectral Profile. Right-click on the Rx Spec-
tral Profile node and select Add Spurious Responses. In the table, add a row and set the
columns as shown below. Note that the value entered for the Frequency column does not con-
tain any variables and is thus a fixed spur, which means that it will appear at 600 MHz for every
channel defined in the Band.

Modify Radio Channels 4-8
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This completes the definition of the Tx and Rx radios for this tutorial.

Modify Radio Channels 4-9
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5 - Antenna Coupling
In general, the coupling between antennas is required for computing cosite EMI. This requires
defining antennas in EMIT and specifying their coupling. EMIT offers several different models for
antenna coupling and these will be covered in detail in later tutorials. In this tutorial, antennas
were added but they were defined as Positionless. This means that EMIT's Global Default Coup-
ling will be used and for this tutorial we want to set the Global Default Coupling to -40 dB. To set
this level, first open the Coupling Editor by either double-clicking either antenna or selecting the
Coupling Editor in the Simulation tab in the ribbon area, shown below.

Select the Coupling Data node in the node tree and set the Global Default Coupling value as
shown below. ClickOK to save the changes.

Antenna Coupling 5-1
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6 - Run the Simulation
At this point, we have a valid EMIT scenario that is ready to simulate. First, select Analyze on
the Simulation tab.

This opens the analysis window and you can learn more about all of the sub-windows it is com-
prised of by clicking the Help icon ( ). The Scenario Matrix is found in the top left corner, and in
this simple tutorial there is only one Tx/Rx pair for the simulation, and only a single Tx/Rx pair
shown in the matrix. The [N to 1] column shows the worst-case interference for the Receiver
caused by any combination of Transmitters. In this scenario, it is disabled because there is only
a single transmitter, Tx-1 (Lo-VHF), that can interfere with the Rx-0 (UHF) receiver. For more
information on EMIT's N-to-1 analysis capabilities, see Tutorial 3.

There are several ways to launch a simulation in EMIT. Here we will run the analysis by selecting
the Run icon ( )above the Scenario Matrix. One can also perform the simulation from the Scen-
ario Matrix by right-clicking on the matrix square for a particular Tx/Rx pair and selecting Run, or
simply by double-clicking on any matrix square. The result is automatically stored in the design’s
Results folder in the Project Manager window, and the analysis window can be re-opened later.

Once the simulation is run, the entries in the Scenario Matrix will update with a color to reflect the
results of the analysis. By default, red indicates a positive EMI margin; i.e., the presence of inter-
ference. Green indicates no interference, and yellow indicates no interference by only a small
margin. These colors can be configured by selecting the By EMI Margin tab at the top-right of the
window. In this case we will use the default values.

Run the Simulation 6-1
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If you haven't done so, run the simulation using one of the aforementioned methods. The bottom
of the Scenario Matrix provides some summary statistics on the run. It displays the Total Chan-
nel Combinations defined in the scenario as well as the Channel Combinations Analyzed. At this
point in this simple tutorial, both of these values should be 1, however, as we will see in later
tutorials, it is possible to run a subset of the total scenario.

Below the Scenario Matrix, the Scenario Details immediately shows us that there is an inter-
ference problem with a +20 dB EMI margin. The Scenario Details allows us to navigate through
the Radios defined within our project to quickly analyze the results. The left side of the Scenario
Details lists all of the transmitters in the project and the right side all of the receivers.

Run the Simulation 6-2
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As different nodes in the Scenario Details are selected, the Interaction Diagram and Result Plot
(shown below) will automatically update to show the results for that node, though in this case all
the results are the same since there is only a single channel combination to analyze.

Run the Simulation 6-3
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In general, a node in the Scenario Details will display the worst-case result for all its sub-nodes.
The one exception is the individual channel nodes which do not have any sub-nodes and thus
show the result for that channel itself. Select the Band nodes in the Scenario Details to expand

Run the Simulation 6-4
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them to show all available channels (as defined by the Samplings) and then select the 50 MHz
and 500 MHz channels, respectively. Normally this would refresh the Result Plot to show the
detailed results for this channel combination, but since it's the only possible combination, its res-
ult was already displayed.

Let's now look at the Result Plot in more detail to better understand the cause of the interference
in our Rx.

As a quick aside, here is an overview of the data displayed in the Result Plot:

l Power at Rx (orange) - this is the power level directly at the input to the receiver. For this
simple 1-1 case, the Power at Rx is the Tx's Spectral Profile plus the antenna-to-antenna
coupling.

Run the Simulation 6-5
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l Rx Spectral Profile (blue) - defined by the Rx Band, Rx Spectral Profile, and any child
nodes (i.e. Mixer Products, Selectivity Profile, Spurious Responses).

l Point EMI Margin (black) - defines the EMI margin for each narrowband spectral com-
ponent.

l Broadband in-channel EMI margin (  ). The EMI margin in the tuned Receiver's chan-
nel bandwidth due to broadband noise.

l Peak in-channel EMI margin ( ) - The EMI margin in the tuned Receiver's channel
bandwidth due to narrowband components that fall within the channel bandwidth.

l EMI Thresholds (red and yellow) - horizontal traces showing the thresholds set in the Res-
ult Categorization window.

l

Plot marker and label ( ) - highlights and provides additional information regarding the
largest cause of interference.

By analyzing the Result Plot we see that there is only one frequency where a positive EMI mar-
gin occurs and that is at the Rx tuned channel frequency of 500 MHz, making it an in-channel
interference problem. It is easily seen that all other EMI margins (that is, Point EMI and Broad-
band in-channel EMI) are below both the yellow and red thresholds that we defined. The plot
marker and label also tell us that this in-channel interference is due to the 10th harmonic of our
transmitter which falls directly on the Rx channel at 500 MHz. Since the harmonic is an unin-
tended emission from our transmitter, this interference can be easily mitigated by adding a low
pass filter to the output of our transmitter which will attenuate the harmonics.

Run the Simulation 6-6
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7 - Add a Filter for Interference Mit-
igation

A simple low pass filter will allow the transmitter's fundamental to pass with little impact but will
attenuate the harmonics sufficiently to eliminate the interference. To add a filter to the Tx, click
on the Filter icon ( ) in the ribbon area and select Low Pass (the type of filter can be modified
later). Insert the Filter between the Tx and its antenna by moving the antenna to the right by left-
clicking and dragging it over with the mouse, then right-clicking on the wire connecting the radio
and the antenna and selecting Delete. Make sure the space between the ports of the radio and
the antenna is wide enough to fit the filter, then move the Filter in between the Tx and antenna
and connect the three components as seen below by either left-clicking on one port and drag-
ging the connection to the next port, or by selecting the Filter and using the Reposition button
found in the ribbon area in the Schematic tab. The Reposition button will automatically move and
connect the component to a valid port. If there are multiple valid connections, then you can cycle
through them by clicking the Reposition button multiple times. Similarly, clicking the Reorient but-
ton will cycle the selected component through all possible orientations. Note that some 2-port
components, most notably Cables and Filters, are orientation agnostic.

Double-click on the Filter to open the Filter Configuration window and set the Filter's properties
as shown below to automatically plot the filter's response.

Add a Filter for Interference Mitigation 7-1
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You may have noticed the previously obtained results have been crossed out in the Project Man-
ager window. The result has been crossed out because it is no longer valid for the design due to
the addition of the filter. Rename the crossed-out result by right-clicking and selecting rename,
changing the name to Result 1 – No filter as shown below. This enables us to review past results
even after running new analyses for modified designs, in order to compare the effects of our
modifications.

Add a Filter for Interference Mitigation 7-2
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Click Analyze under the Simulation ribbon tab to open the analysis window again and re-run the
simulation with the filter included. The Scenario Matrix shows a green square indicating that the
filter successfully mitigated the interference. The Scenario Details also shows that the filter
reduced the EMI margin to -20 dB.

Close the analysis window and rename the new result that was created in the Project Manager
window to Result 2 – With filter. Both the results with and without the filter can now be accessed.

Add a Filter for Interference Mitigation 7-3
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